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View_SPECPR: Software for Plotting 
Spectra (Installation Manual and User’s 
Guide, Version 1.2) 

By Raymond F. Kokaly1 

 

Introduction 
This document describes procedures for installing and using the “View_SPECPR” 

software system to plot spectra stored in SPECPR (SPECtrum Processing Routines) files.  The 
View_SPECPR software is comprised of programs written in IDL  (Interactive Data Language) 
that run within the ENVI (ENvironment for Visualizing Images) image processing system.  
SPECPR files are used by earth-remote-sensing scientists and planetary scientists for storing 
spectra collected by laboratory, field, and remote sensing instruments.  A widely distributed 
SPECPR file is the U.S. Geological Survey (USGS) spectral library that contains thousands of 
spectra of minerals, vegetation, and man-made materials (Clark and others, 2007).  SPECPR files 
contain reflectance data and associated wavelength and spectral resolution data, as well as meta-
data on the time and date of collection and spectrometer settings.  Furthermore, the SPECPR file 
automatically tracks changes to data records through its “history” fields.  For more details on the 
format and content of SPECPR files, see Clark (1993).  For more details on ENVI, see ITT 
(2008).  This program has been updated using an ENVI 4.5/IDL7.0 full license operating on a 
Windows XP operating system and requires the installation of the iTools components of IDL7.0; 
however, this program should work with full licenses on UNIX/LINUX systems.  This software 
has not been tested with ENVI licenses on Windows Vista or Apple Operating Systems. 
 
 

Installation of Software 
1. Download the routines from the following website: 

http://pubs.usgs.gov/of/2008/1183/downloads/ 

2. Unzip the “view_specpr.zip” file to the top level of the C-drive (C:\); this should create a 
new folder C:\view_specpr. 

a. Copy the “view_specpr_1_2.sav” file within the “view_specpr” folder to your ENVI 
“save_add” directory (for installations of ENVI 4.5, the save_add directory is commonly 
in the following location:  C:\ Program Files\ITT\IDL70\products\ENVI45\save_add\). 

                                                           
1 Raymond F. Kokaly, USGS, MS 964 Box 25046, Denver Federal Center, Denver CO 80225, USA. 
raymond@usgs.gov 
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3. Add new entries to your ENVI menu by inserting the following text, highlighted in blue, into 
your ENVI menu configuration file just after the lines that specify the “Window” menu and 
just before the lines at the end of that file that specify the “Help” menu item.  On a typical 
installation of ENVI 4.5, the ENVI menu configuration file is named C:\ Program 
Files\ITT\IDL70\products\ENVI45\menu\envi.men). 

 
0 {Window} 
  1 {Window Finder} {widget controller list} {envi_menu_event} 
  1 {Start New Display Window} {display window} {envi_menu_event} {separator} 
  1 {Start New Vector Window} {vector window} {envi_menu_event} 
  1 {Start New Plot Window} {new window0} {envi_menu_event} 
  1 {Available Files List} {available files list} {envi_menu_event} {separator} 
  1 {Available Bands List} {available bands list} {envi_menu_event} 
  1 {Available Vectors List} {available vectors list} {envi_menu_event} 
  1 {Mouse Button Descriptions} {mouse descriptions} {envi_menu_event} {} 
  1 {Display Information} {display information} {envi_menu_event} 
  1 {Cursor Location/Value} {cursor location} {envi_menu_event} 
  1 {Point Collection} {point collection} {envi_menu_event} 
  1 {Maximize Open Displays} {sort displays} {envi_menu_event} {separator} 
  1 {Link Displays} {link displays} {envi_menu_event} 
  1 {Close All Display Windows} {close all displays} {envi_menu_event} {} 
  1 {Close All Plot Windows} {close all plot windows} {envi_menu_event} 
--------------------------- INSERT TEXT FOLLOWING THIS LINE-------------------- 
0 {User Functions} 
  1 {View_SPECPR} { } {view_specpr} 
--------------------------- INSERT TEXT PRECEEDING THIS LINE------------------- 
0 {Help} 
  1 {Start ENVI Help} {envi help} {envi_menu_event} 
  1 {Mouse Button Descriptions} {mouse descriptions} {envi_menu_event} 
  1 {About ENVI} {about envi} {envi_menu_event} 

 
 

4. Start the ENVI program.  The main menu bar should look like figure 1.   

 

 
Figure 1.  ENVI menu bar with new "User Functions" option. 

 
 

There should be one option under the “User Functions” menu item when you click on it, as 
shown in figure 2. 
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Figure 2.  ENVI menu bar with new SPECPR file viewing option. 

 
 

Running the program to view SPECPR files and plot spectra 
To start the program, click the “View_SPECPR” option under the “User Functions” item 

on the ENVI menu bar.  Figure 3 shows the main program control window that will appear. 
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Figure 3.  Window that controls viewing of SPECPR files. 

 
 

Function 1 – Listing the contents of a SPECPR file. 
1. Select the input SPECPR file by clicking on the “Select SPECPR File” button at the top left 

corner of the widget.  A dialog widget (fig. 4) appears, in which the SPECPR file can be 
selected. 
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Figure 4.  Selecting a SPECPR file. 

 
 

2. In the View_SPECPR control window (fig. 3), click the “List Selected SPECPR File” button.  
Figure 5 shows an example of the file listing that appears after following these two steps.  
Each line in the list shows the record number in the left column, the record title in the second 
column, and the number of data channels or text characters in the third column. If the record 
is a data record, then the date the data were collected is shown in the right column; otherwise, 
the text records do not have an associated collection date, and this column is blank.  If the 
spectrum’s data collection date was not set in the header of the SPECPR data record when it 
was added to the SPECPR file, the column shows the text “no date set”.  Note: not all record 
numbers are listed.  The file listing shows only the beginning record of the set of fixed length 
records in which a spectrum is stored; the listing does not show “continuation records” that 
are used when the data length exceeds the size of the first record.  For more details on record 
lengths and continuation records see Clark (1993).  For example, records 1 to 6 are listed in 
figure 5.  However, the next record listed is record 8.  This is because record 6 has 480 
channels of data that require two records for storage.  The listing does not show record 7, 
which is a continuation record.  The next spectrum stored in the SPECPR file is listed, in this 
case record 8. 
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Figure 5.  An example listing of the contents of a SPECPR file. 

 
 

Function 2 – Navigating through the record list. 
The scroll bar on the right-hand side of the list in figure 5 can be used to scroll through 

the listing of records in the SPECPR file.  The user also can type a record number in the box to 
the right of the “Selected Record Number =” label.  The view in the list box will jump to the area 
of the SPECPR file that contains the closest record to the number input by the user. 

Function 3 – Saving the list of records in the SPECPR file. 
To output a text listing of the contents of a SPECPR file, the user can click the “Save File 

Listing” button in the bottom left corner of the widget.  This will open a file selection widget so 
the user can set the name of a file that will hold a plain text listing of the records in the displayed 
SPECPR file. 
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Function 4 – Plotting the data in a selected record. 
1. Setting the data record.  The user must click on the data record for which the spectral plot is 

desired or enter the record number in the text box next to the “Selected Record Number =” 
label.  Figure 6 shows an example of clicking on record number 77.  Once a data record is 
selected, it will appear “highlighted” in the record list. The text box to the right of the 
selected record number shows the associated wavelength record that is encoded in its header 
information.  Note: in some SPECPR records the associated wavelength record is not set 
correctly. 

 
 

 
Figure 6.  Setting the data record. 

 
 

2. Setting the wavelength record.  Before plotting, the user must set the record number that 
contains the wavelengths of the channels of the spectrometer for which data will be plotted.   
The user can type this record number in the box to the right of the “Wavelength Record =” 
label.  Using the example in figure 5, the number “6” could be entered into the box in order 
to select record 6, with the title of “Wavelengths USGS Denver Beckman STD 1x”, as the 
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wavelength record. After the user clicks “enter” or moves the cursor out of the text box, the 
record number entered will be accepted if it corresponds to a record number in the list.  
Alternatively, the wavelength record can be set using the wavelength record value encoded in 
the header of the data record by clicking the button labeled “<-- set wavelength record to that 
associated with selected record listed above”.  Figure 7 shows an example of setting the 
wavelength to record number 6. 

 
 

 
Figure 7.  Setting the wavelength record. 

 
 
If the user enters a number that does not correspond to a listed record number, then the message 
shown in figure 8 appears, and the value in the wavelength record field is set to a default value of 
1. This could happen if the record number is mistyped or if the wavelength record value in the 
header is not set correctly. 
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Figure 8.  Warning message following an error in wavelength record selection. 

 
 

3. Plotting the data.  The user must click the “Plot Selected Record” button in order to make the 
plot appear.  If the number of channels in the wavelength record, set in step 2, does not match 
the number of channels in the data record, set in step 1, then a warning box will appear, and 
no spectrum will be plotted.  Figure 9 shows an example of plotting record 77 of the example 
SPECPR file using record 6 as the wavelength record.  The plotted spectrum contains all 
valid data in the wavelength and data records; however, the channels that have the SPECPR 
deleted point value (-1.23e+34) are not represented in the plot.  Text describing the SPECPR 
file and record that correspond to the plotted spectrum appears beneath the plot.  Note: The 
plotting function requires the installation of the “iTools” routines distributed by IDL/ENVI; 
the iTools routines usually are installed by default.  Using the built-in functions of the iPlot 
routine of the iTools toolbox, the user may change axes limits, change axes labels, annotate 
the plot, etc.  Consult the IDL documentation on iTools and iPlot for more information.  
Additional spectra can be plotted in new windows by repeating steps 1-3. 

 

 
Figure 9.  Plotting data records. 
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4. Overplotting data.  The user may repeat step 1 and click the “Overplot Selected Record” 
button in order to overlay other spectra collected by the same spectrometer, that is, spectra 
that have the same wavelengths.  The user may also overplot spectra collected with a 
different spectrometer  by selecting new data and wavelength records (repeating steps 1 and 
2) and clicking the “Overplot Selected Record” button.  This can be repeated to plot as many 
records as desired.  Figure 10 shows the state of the main program widget after selecting a 
new data record (29364) and its corresponding wavelength record (10).  Note: new data will 
be overplotted with the last plot or added to the last plot window that the user has clicked in 
or interacted with.  For example, if the user has created two plot windows and wishes to 
overplot a spectrum in the first window that was created, the user can “left-click” on the first 
plot window and then click the “Overplot Selected Record” button in the main program 
widget. 

 
 

 
Figure 10.  Selecting new wavelength and data records. 

 
 
Figure 11 shows an example of overplotting the reflectance spectrum of an aspen leaf on the 
previously created plot of the mineral acmite (record 77). These spectra were measured with 
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different spectrometers.  The new spectrum is shown in a different color, and the text describing 
the SPECPR file and record of this overplotted spectrum is put below the text describing the 
previously plotted spectrum.  While any number of spectra can be overplotted, eventually there 
will not be enough room below the plot for the descriptive text, and that text will not appear in 
the iPlot widget.  This typically occurs after nine spectra have been plotted. Note: The user also 
may select and list the contents of another SPECPR file (using Function 1 described previously) 
and overplot a data record from it by choosing data and wavelength records from the new listing 
and clicking the “Overplot Selected Record” button. 
 
 

 
Figure 11.  Overplotting data records. 

 
 

Function 5 – Viewing the header, text, or DESCRIPT information in a record. 
For a selected record, information about it may be obtained by clicking on the “Show 

Text/Manual History/DESCRIPT of Record” button in the right corner of the main program 
widget (see fig. 3).  There are three different responses, dependent on the type of record selected: 
 

1. Data record.  If the selected record is a data record, for example, record 29364 in figure 10, 
information from the data record header will be displayed as shown in figure 12. 
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Figure 12.  Header information from a data record. 

 
 

2. Text record.  If the selected record is a text record, for example, record 1 in figure 5, the text 
information stored in it will be displayed, as shown in figure 13. 

 
 

 
Figure 13.  Text information from a text record. 

 
 

3. DESCRIPT record.  If the selected record is a description (DESCRIPT) found in published 
USGS spectral library SPECPR files, an internet browser window should open and show 
information that characterizes the spectral library entry.  An example of the information in 
DESCRIPT record 71 is shown in figure 14.  For more information on DESCRIPT records 
and the USGS Spectral Library, see Clark and others (2007).  Note: Photos referred to in the 
html DESCRIPT records may not appear, since the locations of these photos on a user’s 
computer may be different.  Placing the folders containing photos of samples in the spectral 
library in the same directory as the spectral library SPECPR file should result in the photos 
appearing correctly in the browser window. 
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Figure 14.  Example of information in a DESCRIPT record. 

 
 

Function 6 – Viewing the “Help file”. 
The “Help file” (this document) can be opened by clicking on the “Help” menu item at 

the top of the main program widget (see fig. 3) and choosing the “Help on View_SPECPR” 
option that appears.  Select the “View_SPECPR_help.htm” document in the “view_specpr” 
folder extracted from the zip file.  If the user followed the instructions in the “Installation of IDL 
Routines” section, this file will be located at C:\view_specr\view_SPECPR_help.htm.  An 
internet browser window should appear with an html version of this document. 

 13



Function 7 – Exporting a selected record to ASCII text. 
The data within a selected record can be exported to an ASCII text file using the “Export 

selected record to ASCII” button at the bottom of the main program widget (see fig. 3).  A dialog 
box appears asking for the output filename of the ASCII text file (see fig. 15).  A default 
filename is pre-set in the filename box; the pre-set name includes the record number and 
SPECPR filename.  The user may change the output directory and/or the pre-set output filename 
if desired. When ready to save the data to ASCII, press the “Save” button.  Note: This function 
allows you to export all the channels of the data stored in the selected record of the SPECPR file. 
It exports any “deleted points”, also referred to as “deleted channels” in the spectrum as values 
of -1.23e+34 (see the SPECPR documentation; Clark, 1993).  Often, the deleted channels once 
contained invalid or incorrect data, which were identified during error checking.  Sometimes 
deleted channels are set because the spectrometer was configured to collect data over only a 
subset of its full wavelength range capability (see Clark and others, 2007).  

 
 

 
Figure 15.  Setting the output filename for the exported record. 
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Function 8 – Performing continuum removal on a record. 
Linear continuum removal of a spectral feature can be performed on the data in a selected 

record using the “Continuum Removal on selected record” button at the bottom-right of the main 
program widget (see fig. 3).  Continuum removal is used to analyze features in reflectance 
spectra.  For more information on continuum removal, see Clark and Roush (1984), Clark and 
others (2003), and Kokaly and others (2003).  Continuum removal is most commonly performed 
on absorption features.  However, this routine can be used on emission features in addition to 
absorption features.  To perform continuum removal, the user must have already set data and 
wavelength records as described in steps 1-2 of Function 4.  After clicking on the “Continuum 
Removal on selected record” button, a plot window appears with the spectrum of the selected 
record (see fig. 16).  Note: this plot window looks similar to the standard iplot window, except 
that a “continuum removal” tool is on the tool bar (see the tool indicated with the red arrow in 
fig. 16).   

 

 
Figure 16. The iplot window for continuum removal. 

 
 

 15



To perform linear continuum removal, click on the continuum removal tool and draw the 
continuum line over the feature of interest.  Usually, the line will be drawn at the highest points 
on either side of the absorption feature of interest.  Alternatively, for emission features, the line 
is usually drawn from the lowest points on either side of the feature of interest.  The line can be 
drawn by left-clicking at the desired position of the first end point of the line, holding the button 
down, dragging the mouse to the second end point of the line, and releasing the button.  The iplot 
window will update to show the line and its endpoints (see fig. 17), where the end points are the 
channels closest to the endpoints of the line that was drawn. 

 

 
Figure 17. The iplot window after drawing the continuum line. 
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In addition to updating the iplot window, the continuum removal interface GUI 
(graphical user interface) will appear with a plot of the continuum removed feature (see fig. 18).  
In addition, descriptors of the continuum removed feature are shown, including the band center, 
depth, and width (specified as the full-width at half maximum, or FWHM).  Two sets of these 
values are given, one set based on the band center channel (that is, the channel with the 
minimum value in the continuum removed feature) and one set based on a quadratic fit to the 
band center and one channel on each side (that is, a quadratic fit to the three center channels).  
These may often be very close in value when the feature contains a large number of channels.  
The quadratic fit is less subject to noise in the spectrum since it is dependent on more than one 
channel.  The depth and fwhm associated with the quadratic fit are shown as solid lines.  The 
depth and fwhm associated with the band center channel are shown as dotted lines.  Also shown 
in the plot window are descriptors of the continuum line, specifically the slope of the continuum 
line and the ratio of the continuum end point reflectance values. 
 

 
Figure 18. The continuum removal interface GUI window. 
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Using the widgets in this GUI, the user can control aspects of the plot.  These aspects are 
described as five user selections below and their corresponding widgets are labeled in figure 18. 

 
User Selection 1 – setting the plot title.  The GUI appears with the default title set to the 

SPECPR title of the data record.  The user may edit this title. 
User Selection 2 – setting the output postscript filename.  The GUI appears with a suggested 

output filename containing the record number and SPECPR filename.  The 
default directory is set as the directory that contains the SPECPR file.  The user 
may edit this file directly or use the “Select output postscript file” button to use 
an IDL dialog window to set the output postscript file. 

User Selection 3 – setting the continuum start wavelength.  The GUI appears with the start point 
of the continuum line set as the wavelength of the channel closest to the 
endpoint of the line drawn by the user.  This wavelength may be changed by the 
user by editing the valued in the text box.   The channel with the wavelength 
closest to the value in this text box will be used as the start point of the 
continuum line. 

User Selection 4 – setting the continuum stop wavelength.  The GUI appears with the stop point 
of the continuum line set as the wavelength of the channel closest to the 
endpoint of the line drawn by the user.  This wavelength may be changed by the 
user by editing the valued in the text box.   The channel with the wavelength 
closest to the value in this text box will be used as the stop point of the 
continuum line. 

User Selection 5 – Adjust continuum end points.  By default, when the GUI starts, this option is 
turned off.  The user may turn this option on in order to refine the continuum 
end point selection.  Turning this option on will cause the continuum removal 
program to search around the specified end points to find channels above the 
continuum line.  The highest channels above the continuum line will be used to 
recalculate the continuum removed feature when the user presses either the 
“Preview Continuum Removal” or “Create Continuum Removal Postscript File” 
buttons.   

User Selection 6 – Set continuum end points by Channel or by Wavelength.  By default, when 
the GUI starts, this option is set to “wavelength”.  The user may turn this option 
to “channel” in order to refine the continuum end point selection by specifying 
the channel number, in which case the gray boxes containing the channel 
numbers will become active (turn white), and the user may edit the continuum 
start and stop values.  The wavelength boxes will become inactive (turn gray in 
color). 

 
The user selections will be applied when either the “Preview Continuum Removal” or 

“Create Continuum Removal Postscript File” buttons are pressed.  Pressing the “Preview 
Continuum Removal” button will update the plot shown in the GUI to show changes made to any 
of the user selections described above.  For example, figure 19 shows the refreshed plot resulting 
from turning on the automatic selection of continuum end points.  Pressing the “Create 
Continuum Removal Postscript File” will create a postscript version of the plot that is saved to 
the file set in the text box described above in the User Selection 2 section. 

Pressing the “Exit continuum removal” button will cause the program to quit and the GUI 
window to disappear.  The GUI may also be closed by selecting the “Exit” option under the 
“File” item on the GUI’s menubar. 

 18



 

 
Figure 19. Continuum refinement with Adjust Continuum End Points turned on. 

 
For narrow features, drawing the continuum line may be difficult on the initial plot 

window, which shows the full spectrum.  As a result, the user may want to use the iplot “plot 
range” tool (marked with the black arrow in figure 16) to zoom into a specific region of the 
spectrum before drawing the continuum line.  To use this tool, click on the tool’s icon and then 
draw a box around the plot region you wish to see in more detail.  Figure 20 shows an example.  
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Figure 20. Using the plot range tool. 

 
 
The iplot window will update (see fig. 21) to show the selected area in greater detail. 
 

 
Figure 21. The iplot window after using the plot range tool. 
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The user may then select the continuum removal tool and draw the continuum line (see 
fig. 22).  As described previously, the continuum removal interface GUI will launch after 
drawing the continuum line.  NOTE:  it is not recommended that the user launch more than one 
continuum removal interface GUI at a time. 

 

 
Figure 22. The continuum line in the iplot window after using the plot range tool. 

 

Function 9 – Quitting the program. 
The program can be closed by clicking on the “File” menu item in the top left corner of 

the widget (see fig. 3) and choosing the “Quit” option that appears.  Note: The main widget and 
all plot windows and text information boxes will automatically close when quitting the program.  
However, continuum removal plot windows, continuum removal interface GUIs, and 
DESCRIPT windows will not automatically close. 
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iPlot Functions 
This section describes selected functions of the iPlot tool in ENVI/IDL.  For 

comprehensive information on the tool, consult the documentation provided with your installed 
ENVI/IDL version. 

iPlot Function 1 - Export to encapsulated postscript. 
This feature of iPlot allows the user to export the contents of the plot window to an 

encapsulated postscript (eps) file.  The advantage offered by the use of this function is that the 
individual vector elements of the plot (such as the font of the title, the thickness of the x-axis, or 
the color of the plot line) can be manipulated when the eps file is imported into a program such 
as Adobe Illustrator©.  To start the export process, click the export option under the file menu of 
the iPlot window (see fig. 23). 
 
 

 
Figure 23. Exporting the plot to an encapsulated postscript file. 
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1. Select the export destination as “To a File” and click the “Next” button (see fig. 24). 

 
 

 
Figure 24. Exporting the plot to an encapsulated postscript file – step 1. 

 
 

2. Select the export item as the “Window” by clicking on it and click the “Next” button (see fig. 
25). 

 
 

 
Figure 25. Exporting the plot to an encapsulated postscript file – step 2. 
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3. Set the export file type as “Encapsulated Postscript (*.eps)”.  Make sure the “Graphics 
format” is set to “Vector” and not to “Bitmap.”  Set the output filename and click the 
“Finish” button (see fig. 26). 

 
 

 
Figure 26. Exporting the plot to an encapsulated postscript file – step 3. 

 
 

iPlot Function 2 - Export plotted data to ASCII text. 
This feature of iPlot allows the user to export a plotted spectrum’s wavelength or 

reflectance values to an ASCII text file.  The exported data can then be read into other programs.  
Note: This function allows you to export the data displayed in the plot window, which may differ 
from the data stored in the SPECPR record, because “deleted points” are removed from the data 
array before plotting to the iPlot window.  Deleted points are data points with values of -1.23e+34 
(see the SPECPR documentation; Clark, 1993).  To start the export process, click the export 
option under the file menu of the iPlot window (see fig. 23). 
 

1. Select the export destination as “To a File” and click the “Next” button (see fig. 24). 

2. Select the export item as the “X” or “Y” by selecting it and click the “Next” button (see fig. 
27).  By selecting “X” you will export the wavelength data.  By selecting “Y” you will export 
the reflectance data. 
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Figure 27. Exporting data to an ASCII text file – step 2. 

 
 

3. In the next window that appears, make sure the export file type is set to “ASCII Text (*.txt)”.  
Set the output filename and click the “Finish” button (see fig. 28). 

 
 

 
Figure 28. Exporting data to an ASCII text file – step 3. 
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Release Notes 
February, 2008.  Release of version 1.2. Updated with ENVI 4.5/IDL7.0 software. 

Some routines were revised to increase the speed of reading SPECPR files.  The continuum 
removal and export to ASCII capabilities were added. 
Known issues: 

- If the user has opened a large number of iplot windows (more than 10), they may 
not all automatically disappear when exiting View_SPECPR. 

- Opening more than one continuum removal window can lead to unstable behavior 
in the interface GUI windows; specifically, plots will only update in the last GUI 
to be opened. 

- Automatic end point selection will not adjust end points for emission features.  
Instead, it will find the closest absorption feature. 

September, 2005.  Original release to public. 
This program was designed for full ENVI 4.1/IDL6.1 licenses on Windows operating 
systems and requires the installation of the iTools components of IDL6.1.   
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